
The  Arduino  Uno  is  a  microcontroller  board  based  on  the  ATmega328  (datasheet).  It  has  14  digital 
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a 
USB connection,  a power jack,  an ICSP header,  and a reset  button.  It  contains everything needed to 
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC 
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI 
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB 
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions, 
see the index of Arduino boards.

http://arduino.cc/en/Main/Boards
http://www.atmel.com/dyn/resources/prod_documents/doc8161.pdf


EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA

Flash Memory 32 KB of which 0.5 KB used by 
bootloader

SRAM 2 KB 
EEPROM 1 KB 
Clock Speed 16 MHz



The Arduino Uno can be powered via the USB connection or with an external power supply. The power  
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter 
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a 
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V 
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage 
regulator may overheat and damage the board.  The recommended range is 7 to 12 volts.

The power pins are as follows: 

• VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 
5 volts from the USB connection or other regulated power source). You can supply voltage through 
this pin, or, if supplying voltage via the power jack, access it through this pin. 

• 5V. The regulated power supply used to power the microcontroller and other components on the 
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another 
regulated 5V supply. 

• 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA. 
• GND. Ground pins. 

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It  
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and 
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and 
has an internal  pull-up resistor  (disconnected by default)  of  20-50 kOhms.  In  addition,  some pins have 
specialized functions: 

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are 
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip . 

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a 
rising or falling edge, or a change in value. See the attachInterrupt() function for details. 

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function. 
• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, 

although provided by the underlying hardware, is not currently included in the Arduino language. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is  
on, when the pin is LOW, it's off. 

http://arduino.cc/en/Reference/AnalogWrite
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/PinMode
http://www.arduino.cc/en/Reference/EEPROM


The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By  
default they measure from ground to 5 volts, though is it possible to change the upper end of their range 
using  the  AREF  pin  and  the  analogReference()  function.  Additionally,  some  pins  have  specialized 
functionality: 

• I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire library. 

There are a couple of other pins on the board: 

• AREF. Reference voltage for the analog inputs. Used with analogReference(). 
• Reset. Bring this line LOW to reset  the microcontroller.  Typically  used to add a reset  button to 

shields which block the one on the board. 

See also the mapping between Arduino pins and Atmega328 ports. 

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other 
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on 
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB 
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB 
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the 
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins. 

The  ATmega328 also support  I2C (TWI) and SPI communication. The Arduino software includes a Wire 
library to simplify use of the  I2C bus; see the  documentation for details. To use the SPI communication, 
please see the ATmega328 datasheet. 

The  Arduino  Uno  can  be  programmed  with  the  Arduino  software  (download).  Select  "Arduino  Uno  w/ 
ATmega328" from the  Tools > Board menu (according to the microcontroller on your board). For details,  
see the reference and tutorials. 

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code 
to  it  without  the use of  an external  hardware  programmer.  It  communicates  using the original  STK500 
protocol (reference, C header files). 

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,  
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and  
then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac 
OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer 
(overwriting the DFU bootloader). 

http://dfu-programmer.sourceforge.net/
http://www.atmel.com/dyn/products/tools_card.asp?tool_id=3886
http://dev.arduino.cc/wiki/uno/Hacking/Programmer
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://arduino.cc/en/Tutorial/Bootloader
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/Wire
http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Hacking/PinMapping168
http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Reference/AnalogReference


Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a  
way that allows it to be reset by software running on a connected computer. One of the hardware flow control  
lines (DTR)  of  the ATmega8U2 is  connected to  the reset  line of  the ATmega328 via  a  100 nanofarad 
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The 
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the  
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR 
can be well-coordinated with the start of the upload. 

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or 
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or 
so, the bootloader is running on the  Uno. While it is programmed to ignore malformed data (i.e. anything 
besides  an  upload  of  new code),  it  will  intercept  the  first  few bytes  of  data  sent  to  the board  after  a  
connection is opened. If a sketch running on the board receives one-time configuration or other data when it  
first  starts,  make sure  that  the  software  with  which  it  communicates  waits  a  second after  opening the  
connection and before sending this data. 

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can  
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset 
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details. 

The  Arduino  Uno has  a  resettable  polyfuse  that  protects  your  computer's  USB ports  from shorts  and 
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer 
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection 
until the short or overload is removed. 

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector 
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to 
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple 
of the 100 mil spacing of the other pins. 

http://www.arduino.cc/cgi-bin/yabb2/YaBB.pl?num=1213719666/all


Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed  using  the  Arduino  programming  language (based  on  Wiring)  and  the  Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions.  http://arduino.cc/en/Guide/HomePage

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your 
first  program on the arduino board. To 
select “blink led”, the physical translation 
of  the  well  known  programming  “hello 
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

In Tools>Board select

Now you have to go to
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to.

http://arduino.cc/en/Guide/HomePage
http://www.processing.org/
http://wiring.org.co/
http://arduino.cc/en/Reference/HomePage




1.      Warranties 

1.1     The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The 
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,  
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from 
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems 
necessary.

1.2     If any  products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability 
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the 
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3     EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4     Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the 
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other 
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5     The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause 
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapons systems. Arduino products are neither designed nor intended for use in military or aerospace applications or 
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino products which  is solely 
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its 
products and any use of Arduino products in Customer's applications, notwithstanding any applications-related information or support that may be 
provided by the producer.

2.       Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,  
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this 
terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3.        Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or  
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the 
possibility of such damages. This section will survive the termination of the warranty period.

4.      Changes to specifications

The producer  may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or 
characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is 
subject to change without notice. Do not finalize a design with this information.

The producer of Arduino  has joined the Impatto Zero® 
policy of LifeGate.it. For each Arduino board produced is 
created / looked after half  squared Km of Costa Rica’s 
forest’s.
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HC-05 

-Bluetooth to Serial Port Module  

Overview 

 
HC-05 module is an easy to use Bluetooth SPP (Serial Port Protocol) module, designed for 

transparent wireless serial connection setup.  

Serial port Bluetooth module is fully qualified Bluetooth V2.0+EDR (Enhanced Data Rate) 3Mbps 

Modulation with complete 2.4GHz radio transceiver and baseband. It uses CSR Bluecore 

04-External single chip Bluetooth system with CMOS technology and with AFH(Adaptive 

Frequency Hopping Feature). It has the footprint as small as 12.7mmx27mm. Hope it will simplify 

your overall design/development cycle. 

Specifications 

Hardware features  

 Typical -80dBm sensitivity  

 Up to +4dBm RF transmit power   

 Low Power 1.8V Operation ,1.8 to 3.6V I/O  

 PIO control 

 UART interface with programmable baud rate  

 With integrated antenna  

 With edge connector  
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Software features  

 Default Baud rate: 38400, Data bits:8, Stop bit:1,Parity:No parity, Data control: has. 

Supported baud rate: 9600,19200,38400,57600,115200,230400,460800.  

 Given a rising pulse in PIO0, device will be disconnected.  

 Status instruction port PIO1: low-disconnected, high-connected;  

 PIO10 and PIO11 can be connected to red and blue led separately. When master and slave 

are paired, red and blue led blinks 1time/2s in interval, while disconnected only blue led 

blinks 2times/s.  

 Auto-connect to the last device on power as default.  

 Permit pairing device to connect as default.  

 Auto-pairing PINCODE:”0000” as default  

 Auto-reconnect in 30 min when disconnected as a result of beyond the range of connection. 

 

 

Hardware 
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AT command Default: 

 How to set the mode to server (master):  

1. Connect PIO11 to high level. 

2. Power on, module into command state. 

3. Using baud rate 38400, sent the “AT+ROLE=1\r\n” to module, with “OK\r\n” 

means setting successes. 

4. Connect the PIO11 to low level, repower the module, the module work as server 

(master). 

  

AT commands: (all end with \r\n)  

1. Test command: 

Command Respond Parameter 

AT OK - 

2. Reset 

Command Respond Parameter 

AT+RESET OK - 

 

3. Get firmware version 

Command Respond Parameter 

AT+VERSION? +VERSION:<Param> 

OK 

Param : firmware version 

Example:  

AT+VERSION?\r\n  

+VERSION:2.0-20100601  

OK  
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4. Restore default 

Command Respond Parameter 

AT+ORGL OK - 

Default state: 

Slave mode, pin code :1234, device name: H-C-2010-06-01 ,Baud 38400bits/s. 

 

5. Get module address 

Command Respond Parameter 

AT+ADDR? +ADDR:<Param> 

OK 

Param: address of Bluetooth 

module 

Bluetooth address: NAP: UAP : LAP 

Example:  

AT+ADDR?\r\n  

+ADDR:1234:56:abcdef  

OK  

 

6. Set/Check module name: 

Command Respond Parameter 

AT+NAME=<Param> OK Param: Bluetooth module 

name 

(Default :HC-05) 

AT+NAME? +NAME:<Param> 

OK (/FAIL) 

Example: 

AT+NAME=HC-05\r\n    set the module name to “HC-05”  

OK  

AT+NAME=ITeadStudio\r\n                             

OK  

AT+NAME?\r\n  

+NAME: ITeadStudio 

OK  

 

7. Get the Bluetooth device name: 

Command Respond Parameter 

AT+RNAME?<Param1> 1. +NAME:<Param2> 

  OK 

2. FAIL 

Param1,Param 2 : the address 

of Bluetooth device 

Example:  (Device address 00:02:72:od:22:24，name：ITead)  

AT+RNAME? 0002，72，od2224\r\n  

+RNAME:ITead  

OK  

  

8. Set/Check module mode: 

Command Respond Parameter 

AT+ROLE=<Param> OK Param: 

0- Slave AT+ ROLE? +ROLE:<Param> 
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OK 1-Master 

2-Slave-Loop 

 

9. Set/Check device class 

Command Respond Parameter 

AT+CLASS=<Param> OK Param: Device Class 

AT+ CLASS? 1. +CLASS:<Param> 

OK 

2. FAIL 

 

10. Set/Check GIAC (General Inquire Access Code) 

Command Respond Parameter 

AT+IAC=<Param> 1.OK 

2. FAIL 

Param: GIAC 

(Default : 9e8b33) 

AT+IAC +IAC:<Param> 

OK 

Example: 

AT+IAC=9e8b3f\r\n  

OK  

AT+IAC?\r\n  

+IAC: 9e8b3f  

OK  

  

11. Set/Check -- Query access patterns 

Command Respond Parameter 

AT+INQM=<Param>,<Param2>, 

<Param3> 

1.OK 

2. FAIL 

Param: 

0——inquiry_mode_standard  

1——inquiry_mode_rssi 

Param2: Maximum number of 

Bluetooth devices to respond 

to 

Param3: 

Timeout (1-48 : 1.28s to 

61.44s) 

 

 

AT+ INQM? +INQM： <Param>,<Param2>, 

<Param3>  

OK 

Example: 

AT+INQM=1,9,48\r\n 

OK  

AT+INQM\r\n  

+INQM:1, 9, 48  

OK 
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12. Set/Check PIN code: 

Command Respond Parameter 

AT+PSWD=<Param> OK Param: PIN code 

(Default 1234) 

 

AT+ PSWD? + PSWD  ：<Param>  

OK 

 

13. Set/Check serial parameter: 

Command Respond Parameter 

AT+UART=<Param>,<Param2>,<

Param3> 

OK Param1: Baud 

Param2: Stop bit 

Param3: Parity 

 

AT+ UART? +UART=<Param>,<Param2>, 

<Param3>   

OK 

Example: 

AT+UART=115200，1,2,\r\n  

OK  

AT+UART?  

+UART:115200,1,2  

OK  

 

14. Set/Check connect mode: 

Command Respond Parameter 

AT+CMODE=<Param> OK Param: 

0 - connect fixed address 

1 - connect any address 

2 - slave-Loop 

AT+ CMODE? + CMODE:<Param> 

OK 

 

15. Set/Check fixed address: 

Command Respond Parameter 

AT+BIND=<Param> OK Param: Fixed address 

(Default 

00:00:00:00:00:00) 

AT+ BIND? + BIND:<Param> 

OK 

Example: 

AT+BIND=1234，56，abcdef\r\n  

OK  

AT+BIND?\r\n  

+BIND:1234:56:abcdef  

OK  

 

16. Set/Check LED I/O 

Command Respond Parameter 

AT+POLAR=<Param1,<Param2> OK Param1:  

0- PIO8 low drive LED 

1- PIO8 high drive LED 

AT+ POLAR? + POLAR=<Param1>,<Param2> 

OK 
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Param2:  

0- PIO9 low drive LED 

1- PIO9 high drive LED 

 

 

17. Set PIO output 

Command Respond Parameter 

AT+PIO=<Param1>,<Param2> OK Param1: PIO number 

Param2: PIO level 

 0- low 

 1- high 

 

Example: 

1. PIO10 output high level 

AT+PI0=10，1\r\n 

OK  

 

18. Set/Check – scan parameter 

Command Respond Parameter 

AT+IPSCAN=<Param1>,<Param2

>,<Param3>,<Param4> 

OK Param1: Query time 

interval  

Param2：Query duration  

Param3：Paging interval  

Param4：Call duration 

AT+IPSCAN? +IPSCAN:<Param1>,<Param2>,<P

aram3>,<Param4>  

OK 

Example: 

AT+IPSCAN =1234,500,1200,250\r\n  

OK  

AT+IPSCAN?  

+IPSCAN:1234,500,1200,250  

  

 

19. Set/Check – SHIFF parameter 

Command Respond Parameter 

AT+SNIFF=<Param1>,<Param2>,

<Param3>,<Param4> 

OK Param1: Max time 

Param2: Min time  

Param3: Retry time 

Param4: Time out 

AT+ SNIFF? +SNIFF:<Param1>,<Param2>,<Par

am3>,<Param4>  

OK 

 

20. Set/Check security mode 

Command Respond Parameter 

AT+SENM=<Param1>,<Param2> 1. OK 

2. FAIL 

Param1:  

0——sec_mode0+off  

1——sec_mode1+non_seAT+ SENM? + SENM:<Param1>,<Param2> 
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OK cure  

2——sec_mode2_service  

3——sec_mode3_link  

4——sec_mode_unknow

n  

Param2: 

0——hci_enc_mode_off  

1——hci_enc_mode_pt_t

o_pt  

2——hci_enc_mode_pt_t

o_pt_and_bcast 

 

21. Delete Authenticated Device 

Command Respond Parameter 

AT+PMSAD=<Param> OK Param:  

Authenticated Device 

Address 

Example: 

AT+PMSAD =1234,56,abcdef\r\n  

OK  

 

22. Delete All Authenticated Device 

Command Respond Parameter 

AT+ RMAAD  OK - 

 

 

23. Search Authenticated Device 

Command Respond Parameter 

AT+FSAD=<Param> 1. OK 

2. FAIL 

Param: Device address 

 

24. Get Authenticated Device Count 

Command Respond Parameter 

AT+ADCN? +ADCN：<Param> 

OK 

Param: Device Count 

 

25. Most Recently Used Authenticated Device 

Command Respond Parameter 

AT+MRAD? + MRAD：<Param> 

OK 

Param: Recently 

Authenticated Device 

Address 

 

26. Get the module working state 

Command Respond Parameter 
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AT+ STATE? + STATE：<Param> 

OK 

Param:  

“INITIALIZED” 

“READY”  

“PAIRABLE” 

“PAIRED” 

“INQUIRING” 

“CONNECTING” 

“CONNECTED” 

“DISCONNECTED” 

“NUKNOW” 

 

27. Initialize the SPP profile lib 

Command Respond Parameter 

AT+INIT 1. OK 

2. FAIL 

- 

 

28. Inquiry Bluetooth Device 

Command Respond Parameter 

AT+INQ +INQ: <Param1>，  <Param2>， 

<Param3> 

…. 

OK 

Param1：Address  

Param2：Device Class 

Param3 ： RSSI Signal 

strength 

Example: 

AT+INIT\r\n     

OK  

AT+IAC=9e8b33\r\n  

OK  

AT+CLASS=0\r\n  

AT+INQM=1,9,48\r\n  

At+INQ\r\n  

+INQ:2:72:D2224,3E0104,FFBC  

+INQ:1234:56:0,1F1F,FFC1  

+INQ:1234:56:0,1F1F,FFC0  

+INQ:1234:56:0,1F1F,FFC1  

+INQ:2:72:D2224,3F0104,FFAD  

+INQ:1234:56:0,1F1F,FFBE  

+INQ:1234:56:0,1F1F,FFC2  

+INQ:1234:56:0,1F1F,FFBE  

+INQ:2:72:D2224,3F0104,FFBC  

OK  

  

28. Cancel Inquiring Bluetooth Device 

Command Respond Parameter 

AT+ INQC OK - 
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29. Equipment Matching 

Command Respond Parameter 

AT+PAIR=<Param1>,<Param2> 1. OK 

2. FAIL 

Param1：Device Address 

Param2：Time out 

 

30. Connect Device 

Command Respond Parameter 

AT+LINK=<Param> 1. OK 

2. FAIL 

Param：Device Address 

Example: 

AT+FSAD=1234,56,abcdef\r\n  

OK  

AT+LINK=1234,56,abcdef\r\n  

OK  

 

31. Disconnect 

Command Respond Parameter 

AT+DISC 1. +DISC:SUCCESS 

  OK 

2. +DISC:LINK_LOSS 

  OK 

3. +DISC:NO_SLC 

  OK 

4. +DISC:TIMEOUT 

  OK 

5. +DISC:ERROR 

  OK 

Param：Device Address 

 

32. Energy-saving mode 

Command Respond Parameter 

AT+ENSNIFF=<Param> OK Param：Device Address 

 

 

33. Exerts Energy-saving mode  

  

Command Respond Parameter 

AT+ EXSNIFF =<Param> OK Param：Device Address 
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Light Dependent Resistor - LDR 
Two cadmium sulphide(cds) photoconductive cells with spectral responses 
similar to that of the human eye. The cell resistance falls with increasing light 
intensity. Applications include smoke detection, automatic lighting control, 
batch counting and burglar alarm systems. 

Applications 
Photoconductive cells are used in many different types of circuits and 
applications. 
 
Analog Applications 

• Camera Exposure Control 
• Auto Slide Focus - dual cell 
• Photocopy Machines - density of toner 
• Colorimetric Test Equipment 
• Densitometer 
• Electronic Scales - dual cell 
• Automatic Gain Control – modulated light 

source 
• Automated Rear View Mirror 

 
Digital Applications 

• Automatic Headlight Dimmer 
• Night Light Control 
• Oil Burner Flame Out 
• Street Light Control 
• Absence / Presence (beam breaker) 
• Position Sensor 

 
 

 

Electrical Characteristics 
Parameter Conditions

  
Min Typ Max Unit 

Cell resistance 1000 LUX 
10 LUX 

- 
- 

400 
9 

- 
- 

Ohm 
K Ohm 

Dark Resistance - - 1 - M Ohm 
Dark Capacitance - - 3.5 - pF 
Rise Time 1000 LUX 

10 LUX 
- 
- 

2.8 
18 

- 
- 

ms 
ms 

Fall Time 1000 LUX 
10 LUX 

- 
- 

48 
120 

- 
- 

ms 
ms 

Voltage AC/DC Peak  - - 320 V max 
Current  - - 75 mA max 
Power Dissipation    100 mW max 
Operating 
Temperature 

 -60 - +75 Deg. C 

 

mailto:info@sunrom.com
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Guide to source illuminations 
Light source Illumination LUX  
Moonlight 0.1 
60W Bulb at 1m 50 
1W MES Bulb at 0.1m 100 
Fluorescent Lighting 500 
Bright Sunlight 30,000 
 

Sensitivity 
The sensitivity of a photodetector is the relationship between the light falling on the device and the 
resulting output signal. In the case of a photocell, one is dealing with the relationship between the 
incident light and the corresponding resistance of the cell. 
 
FIGURE 2 RESISTANCE AS FUNCTION OF ILLUMINATION 

 

Spectral Response 
Figure 3 Spectral response  

Like the human eye, the relative sensitivity of a 
photoconductive cell is dependent on the 
wavelength (color) of the incident light. Each 
photoconductor material type has its own unique 
spectral response curve or plot of the relative 
response of the photocell versus wavelength of 
light. 
 
 
 
 
 
  

FIGURE 1 CIRCUIT SYMBOL 

 

R1
LDR SUNROM #3190
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Dimensions 

 
Typical Application Circuits 
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APPLICATION NOTE 
 

TEMPERATURE COMPENSATION  
WITH pH MEASUREMENT 
 

Is there a temperature compensation table for pH measurement in samples? 
 

The temperature coefficient of a sample is normally not known. Therefore no table exists correlating sample 
pH with temperature, as known from pH buffer solutions. That is why no exact temperature compensation 
can be made with sample measurements. 
 
In order to correct the pH value of a sample to the calibration temperature, the following formula is 
commonly used in pH meter software. 

S(T sample) = S(T cal) * 

T(sample) + 
273.15 

T(cal) = 273.15 
S = slope 
T = temperature °C 
cal = calibration 

 

With the new calculated slope S(T sample) from the mV signal, the pH of the sample can be calculated at 
sample temperature T(sample). A linear relationship is assumed between sample pH and temperature. 
 

Example: 
 

Calibration was done with pH buffers 4.01 and 7.00 at 24°C. The samples have been stored cool and now the 
measurement is done at 10°C. 
 

The corrected pH value is calculated with slope (24°C) = -58,0 mV/pH and offset = 0.0mV: 
Slope (10°C) = slope(24°C) * (10 + 273.15) / (24 + 273.15) 
Slope (10°C) = -58.0 * (283.15) / ( 297.15) 
Slope (10°C) = -55.28 mV/pH 
 

pH value of the sample (measured potential +100 mV) 
= 7 – 100 mV / -58.0 mV/pH = pH 5.28 (not corrected), 
= 7 – 100 mV / -55.28 mV/pH = pH 5.19 (corrected) 

 

The difference of 0.09 pH shows how important it is to precisely measure and correct for temperature. 
 
FOR TECHNICAL ASSISTANCE, PRICE INFORMATION AND ORDERING:  
Tel: 800-227-4224   |   E-Mail: techhelp@hach.com  
To locate the HACH office or distributor serving you, visit: www.hach.com 
 
LIT2007 
© Hach Company, 2013.  All rights reserved. 
In the interest of improving and updating its equipment, Hach Company reserves the right to alter specifications to equipment at any time. 



PH meter temperature compensation 

 

 

Since there is no temperature sensor in the PH meter KIT, this temperature compensation is 

just a theoretical formula.  

It hasn't been verified by the specialized equipment.  

/* pHConversion: converts the voltage value into a pH value updating 

the sensitivity 

 *       in function of the temperature change 

 * Parameters: float input    : voltage measured at the sensor 

output 

 *     float cal_1    : voltage measured with the 

10.0pH calibration solution 

 *     float cal_2    : voltage measured with the 

7.0pH calibration solution 

 *     float cal_3    : voltage measured with the 

4.0pH calibration solution 

 *     float temp     : temperature of the test 

solution 

 *     float temp_cal : temperature of the 

calibration solutions 

 *  Return:  float value : the pH of the solution 

 *        - -1 : wrong 

temperature introduced 

 *        - -2 : wrong 

calibration temperature introduced 

 *  

 */ 

float WaspSensorSW::pHConversion(float input, float cal_1, float cal_2, 

float cal_3, float temp, float temp_cal) 

{ 

 float value; 

 float zero_value; 

 float sensitivity; 

  

 if( (temp < 0)||(temp > 100) ) 

 { 

  return -1.0; 

 } 

 if((temp_cal < 0)||(temp_cal > 100)) 

 { 

  return -2.0; 

 } 

  

 // The value at pH 7.0 is taken as reference 

 zero_value = cal_2; 

  

 // The sensitivity is calculated using the other two calibration 

values 

 sensitivity = (cal_3-cal_1)/6; 

 

 // Add the change in the conductivity owed to the change in 

temperature 

 sensitivity = sensitivity + (temp - temp_cal)*0.0001984; 

  

 // pH value calculated from the calibration values 



 value = 7.0 + (zero_value-input)/sensitivity; 

  

 return value; 

} 

 

 

PH meter self-checking 

This part will tell you how to check whether you get a fault ph meter. note: it is only suitable 

for V1.  

1. Make sure the power supply is standard 5.0V (Some computer can't provide enough power 

supply with 5V, generally it will be 4.8V or 4.9V)  

2. Power the ph convert board, follow the picture and measure the voltage of two 

capacitances. It should be close to 5V. (purple)  

 

Analog pH Meter Kit V1 

3.Short current the BNC connector, like what I did in the photo. If you have a multimeter, 

measure its analog pin, it should be 2V. If you don't have multimeter. Connect the adapter to 

Arduino board, run the sample code. it should output PH:7 in the serial monitor.  

https://www.dfrobot.com/wiki/index.php/File:Self-checking.PNG


 

Analog pH Meter Kit V1 

4.If everything goes well. It should work well. But don't forget to calibration. 

Note:  

 Please keep PH convert board clear, and leave it far away from the water. It is not a 
wateproof device. 

 It is a chemical device, the output value will exist some delay time when you plug it in the 
solution. pleas wait 30s. waiting its stable state. 

 Random value: please check the BNC connector, when the connector is not well, it will 
output random signal. 

 

https://www.dfrobot.com/wiki/index.php/File:Self-checking.jpG


 

//motor DC 

// kabel hitam motor bertemu dengan pin 6 kabel hitam motor 14 

 

int kananA = 8; // 15 

int kananB = 9; //10     

int kiriA = 10; //7 

int kiriB = 11;//2 

 

#define SensorPin A0            //pH meter Analog output to Arduino Analog Input 0 

#define Offset 0.00            //deviation compensate 

#define LED 13 

#define samplingInterval 20 

#define printInterval 800 

#define ArrayLenth  40    //times of collection 

int pHArray[ArrayLenth];   //Store the average value of the sensor feedback 

int pHArrayIndex=0;  

void setup()  

{ 

  Serial.begin(9600); 

   

  pinMode(kananA,OUTPUT); 

  pinMode(kananB,OUTPUT); 

  pinMode(kiriA,OUTPUT); 

  pinMode(kiriB,OUTPUT); 



   pinMode(LED,OUTPUT);   

  Serial.begin(9600);   

  Serial.println("pH meter experiment!");    //Test the serial monitor 

} 

 

void loop() 

{  

      

   

 if (digitalRead(7) == HIGH) {         // check if the input is HIGH (button released) 

analogWrite(kananA,255);//maju 

  analogWrite(kananB,0); 

  analogWrite(kiriA,255); 

  analogWrite(kiriB,0); 

  delay (1000);}   

     

  if (digitalRead(6) == HIGH) {         // check if the input is HIGH (button released) 

analogWrite(kananA,0); //mundur 

  analogWrite(kananB,255); 

  analogWrite(kiriA,0); 

  analogWrite(kiriB,255); 

 delay (1000); }  

    

   if (digitalRead(5) == HIGH){         // check if the input is HIGH (button released) 

 analogWrite(kananA,255); //kanan 



  analogWrite(kananB,0); 

  analogWrite(kiriA,0); 

  analogWrite(kiriB,255); 

 delay (1000); }     

  if (digitalRead(4) == HIGH) {         // check if the input is HIGH (button released) 

analogWrite(kananA,0); //kiri 

  analogWrite(kananB,255); 

  analogWrite(kiriA,255); 

  analogWrite(kiriB,0); 

 delay (1000); }   

   else { 

    analogWrite(kananA,0);//maju 

  analogWrite(kananB,0); 

  analogWrite(kiriA,0); 

  analogWrite(kiriB,0); 

  } 

  

 

 static unsigned long samplingTime = millis(); 

  static unsigned long printTime = millis(); 

  static float pHValue,voltage; 

  if(millis()-samplingTime > samplingInterval) 

  { 

      pHArray[pHArrayIndex++]=analogRead(SensorPin); 

      if(pHArrayIndex==ArrayLenth)pHArrayIndex=0; 



      voltage = avergearray(pHArray, ArrayLenth)*5.0/1024; 

      pHValue = 3.5*voltage+Offset; 

      samplingTime=millis(); 

  } 

  if(millis() - printTime > printInterval)   //Every 800 milliseconds, print a numerical, convert the state of 

the LED indicator 

  { 

  Serial.print("Voltage:"); 

        Serial.print(voltage,2); 

        Serial.print("    pH value: "); 

  Serial.println(pHValue,2); 

        digitalWrite(LED,digitalRead(LED)^1); 

        printTime=millis(); 

  } 

   

} 

double avergearray(int* arr, int number){ 

  int i; 

  int max,min; 

  double avg; 

  long amount=0; 

  if(number<=0){ 

    Serial.println("Error number for the array to avraging!/n"); 

    return 0; 

  } 

  if(number<5){   //less than 5, calculated directly statistics 



    for(i=0;i<number;i++){ 

      amount+=arr[i]; 

    } 

    avg = amount/number; 

    return avg; 

  }else{ 

    if(arr[0]<arr[1]){ 

      min = arr[0];max=arr[1]; 

    } 

    else{ 

      min=arr[1];max=arr[0]; 

    } 

    for(i=2;i<number;i++){ 

      if(arr[i]<min){ 

        amount+=min;        //arr<min 

        min=arr[i]; 

      }else { 

        if(arr[i]>max){ 

          amount+=max;    //arr>max 

          max=arr[i]; 

        }else{ 

          amount+=arr[i]; //min<=arr<=max 

        } 

      }//if 

    }//for 



    avg = (double)amount/(number-2); 

  }//if 

  return avg; 

  

 

   

 

} 
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